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1. Current Version Information
• V0.98, 2012-11-18, Beta release Candidate

2. Download
Download Link: http://www.k8ut.com/tiki-list_file_gallery.php?galleryId=14

3. Purpose
For many hams, applications for operating awards (DXCC, WAS, WAZ, WPX, VUCC) represent the final
phase of the QSL process. When applying for those awards using LoTW, the ham purchases Award Credits
which apply to specific QSOs in his log. Those credits and the QSOs to which they apply may be listed in an
ARRL Award Report (in the case of submitted paper cards) or the Logbook of the World (LoTW) Credit
Application (in the case of LoTW credits purchased on-line).
Up until now, the last step of the Award Application and Credit Purchase process involved the tedious task of
setting the Award Flags for each credited QSO in your DX4Win log.
LoTWCreditToDX4Win automates this last step by examining each credited QSO in the LoTW Credit Report
from the ARRL and setting the corresponding Award Flags in your DX4Win log.

3.1. Explained in DX4Win Terms
DX4Win users should be familiar with standard reports that indicate the QSL phases as "W"orked, "L"abeled to
send a card, "M"ailed the card and waiting for reply, "C"onfirmed card received (or LoTW confirmed),
"S"ubmitted to ARRL for award credit, and finally an "*" (asterisk) to indicate awarded credit.
LoTWCreditToDX4Win places "C"s in the Award Flags at the bottom of the QSO Entry Window, which
results in "*" asterisks on the standard reports.
DX4Win Award Flags may have one of four values:
o
o
o
o

(blank) - no award activity
I - Ignore this QSO for this award
S - Submitted to the ARRL for award credit
C - Checked by the ARRL and approved for award credit

If you cannot see this list at the bottom of your QSO Entry Window, press the F5 key repeatedly to expand and
shrink your screen.

4. Features
o
o
o
o
o
o

Processes award credit records for paper QSLs and on-line LoTW award credits (if you have a
blended record on the LoTW website)
Sets Award Flags in the DX4Win log, resulting in "*" asterisks in the DX4Win standard reports
Band/mode comparisons include CW, SSB, RTTY, PSK31 modes, and bands from 160 to 2
meters
Includes operating awards for DXCC, WAZ, WAS, WPX, or VUCC credits from the ARRL
Generates a report for every LoTW Credit record for which there is no matching QSO in your
DX4Win log
Generates an audit report listing every change made to the DX4Win log

5. Requirements
5.1. Computer Requirements
o
o
o
o
o

DX4Win version 8.01 or later
DXLabs DXKeeper version 10.6 or later
Microsoft Windows XP or later
Windows .NET framework v4.0 or later
A reasonably fast computer with lots of RAM

NOTE: This is a Microsoft .NET application written in Visual Basic 2010. When attempting to run the software
for the first time, you may be prompted to install the latest version of .NET on your computer.

5.2. Data Requirements - two data files
o
o

A DXQ file exported from you DX4WINv8 log – use DX4Win’s >File >Import/Export menu to
produce this file
An LoTW Credit TXT file from DXLabs DXKeeper – see addendum for DXKeeper installation

6. Installation
Installing the program is simple, there is no setup program. Extract LoTWCreditToDX4Win.EXE from the ZIP
archive and save it to any directory on your PC. To run the program, use Windows Explorer to navigate to the
directory in which you saved the program, then double-click on the program icon. You can also create a
shortcut to the program on your desktop.
The ZIP archive contains two small sample files (LOTWsamplefile.txt credit and LOTWSamplefile.DXQ
export) for experimentation purposes.

7. Operation
7.1. Launch LoTWCreditToDX4Win.EXE and follow the numbered steps
1. Select the LoTW .TXT Award Credit Report that you obtained from DXKeeper
2. Select the DX4Win v8 .DXQ file that you exported from your log
3. Select the Award Type (DXCC, WAZ, WAS, WPX, VUCC) corresponding to the LoTW .TXT Award
Credit report
4. Press the <Update DXQ File> button to begin processing
5. Observe the Processing Award Credits status bar
6. LoTWCreditToDX4Win will conclude with a <Done!> button. Before closing the window, make note
of the NIL Error count

7.2. Import the Award Credits into your DX4Win Log
LoTWCreditToDX4Win saves the LoTW credit information back into the .DXQ file. All of your original
QSOs, plus the Award Flags for ARRL credits, are included in the file. However, the exported DXQ file does
not include DX4Win group names and selections from your existing log file, and you will need to import the
DXQ file into your existing log to re-assemble your original information. For this reason, you should proceed
cautiously when importing the new file into your active log.

The .DXQ and .DXN Files
When exporting v8 logs, DX4Win produces two companion files: a .DXQ file with standard log fields, and a
.DXN file with the Note for this Call, Name, and QTH fields. When you import your .DXQ file, make sure that
the .DXN file is in the same directory so that those fields will be imported along with your QSO details.

7.2.1. Examine the Results in a Temporary Log
o
o

o

In DX4Win, create a new, temporary log:
 >File >New... Give the new log a name, and press <Open>
Import the .DXQ records file:
 >File >Import/Export, select DX4Win version 8 as the log description, navigate to the
.DXQ file, and import it into the new log.
Examine the Award Flags at the bottom of the QSO Entry Window, pressing F5 if necessary to
expand the window. Use F8 (Search) to locate QSOs for which you have purchased credits.

Option: Use an Independent Third Party Tool for Confirmation
Jim Reisert, AD1C, has written a utility program for comparing DX4WIN DXCC Credit Status with LoTW
records. You can find Jim's program here: http://dx4win.ad1c.us/lotw/

7.2.2. Make a Backup of Your Existing Log
Copy your existing DX4WIN log (<callsign>.DXL file) to a safe place

7.2.3. Import the Results into Your Existing Log
After you are certain that the awards changes are accurate and after making a backup of your existing log
o
o
o

Open your existing log: >File >Open
Empty the existing log: >QSO >Multiple QSO Operations >Delete QSOs
Import the .DXQ records file: >File >Import/Export
 Select DX4Win version 8 as the log description, navigate to the .DXQ file, and import it
into the existing log

7.3. Examine the NIL (Not In Log) Error Report

LoTWCreditToDX4Win creates an error file listing the LoTW Credits that did not match QSOs in your
DX4Win log. The listing includes the LoTW QSO Number, QSO Date, QSO Time (included in LoTW records,
but blank for paper QSL records), Callsign, Band and Mode. The fields are arranged in fixed column widths
with comma separators, so that you can can open it with a text editor (Notepad) or rename the file to .CSV and
open it with Excel. Inspect each listing in the NIL file and compare it to your DX4Win log to determine why the
two records disagree.
The most common NIL errors are due to:
o
o

o

Data entry errors for paper logs – especially inverted MMDD <> DDMM dates
Callsign disparities. For example:
 KN5G/6Y5 in DX4Win was returned as 6Y5/KN5G from the ARRL
 TK/OM5RW/P in DX4Win was returned as TK/OM5RW from the ARRL
Mode mappings – including the less popular digital modes

7.4. Using an IGNORETHESE.NIL Exclusion File
When you examine your .NIL file, you may find some insignificant discrepancies between your DX4Win log
and the ARRL's records. In my .NIL file there were 50 QSOs in which the QSO date was inadvertently misrecorded by the ARRL data entry staff. For example, a QSO on 12/11/2012 (MM/DD/YYYY) was recorded at
the ARRL as 11/12/12012 (DD/MM/YYYY).
Unfortunately, each time you purchase new LoTW credits and run LoTWCreditToDX4Win, you will encounter
those same QSOs as you examine your .NIL error report. However, there is a way to tell
LoTWCreditToDX4Win to ignore those QSOs. Rename your .NIL file to IGNORETHESE.NIL. All of the
QSOs in IGNORETHESE.NIL will be excluded from the comparison and statistics the next time you run
LoTWCreditToDX4Win. If there is a QSO that you do not want excluded, use a text Editor (Notepad?) and
remove that QSO from the NIL file.

Where to place the IGNORETHESE.NIL file?
The IGNORETHESE.NIL file must be located in the same directory as the LoTWCreditToDX4Win.EXE
program file. This might not be the same directory where your .TXT and .DXQ files are located.

7.5. More Detail - the AUDIT.CSV File
LoTWCreditToDX4Win creates an audit file that describes the decisions and actions it took when processing
each record of the LoTW Credit report. If you need to understand which items were changed (or not) and why,
look at the AUDIT.CSV file. For ease-of-use, open the file with Excel, select the entire spreadsheet with ctrl+A,
and then select >Data >Sort.
To easily study the data, use a nested sort of:
1.
2.
3.
4.

Type
Band/Mixed/Mode
Confirm
Date

8. Data Manipulation
LoTWCreditToDX4Win examines each QSO in your log to decide when it is appropriate to make a change to
your existing award flags. The decision matrix is different for Card Credits than for LoTW Credits. In either
event, the AUDIT.CSV report tells you exactly which fields were changed and which were not changed.

8.1. Card Credits - Which Fields Change?
When examining Card Credit records, LoTWCreditToDX4Win may only change the Mixed/Band/Mode award
flags, and only under certain conditions.
o
o
o
o

If the Band/Mixed/Mode flags are already "CCC" the program obviously makes no changes
If the Band/Mixed/Mode flags are empty - "--" - the program makes no changes
If the Band/Mixed/Mode flags contain at least one "S"ubmitted - in any position - the program
changes that "S"ubmitted to "C"redited
No other fields (Card Confirm or QSL Sent Date) are changed by the program for a Card Credit
record

If the Card Award flags do not contain 'S'ubmits?
If you have not placed an S in the award flags to indicate that the card has been submitted to an ARRL log
checker for credit, LoTWCreditToDX4Win will not change that award flag to C for Credited.

8.2. LoTW Credits - Which Fields Change?
When examining LoTW Credit records, LoTWCreditToDX4Win may only change the Band/Mixed/Mode
award flags, the LoTW Confirm field, and the LoTW Upload Date under the following conditions:
o
o
o

o
o

If the Band/Mixed/Mode flags are already "CCC" the program obviously makes no changes to
the Award flags
If the Band/Mixed/Mode flags contain at least one "S"ubmitted - in any position - the program
changes that "S"ubmitted to "C"redited
If the Band/Mixed/Mode flags are all empty - "--" - the program cannot determine whether this
record applies to a Band, Mixed, or Mode submission, and takes a "shotgun approach" by
changing all Band/Mixed/Mode flags to "C"
If the LoTW Confirm field is "N"o, the program changes the LoTW Confirm field to "Y"es
If the LoTW Upload Date is empty, the program changes the LoTW Upload Date to today's date

9. Known Anomalies




LoTWCreditToDX4Win has been tested on the bands and modes that I operate. If your log contains
frequencies above 2 meters, or modes other than SSB, CW, RTTY and PSK31, you may see unmatched
Credits in your NIL error file.
Other modes and bands could be accommodated with feedback from users about problems they
encounter

9.1. Problems with the ARRL LoTW Credit report - Insufficient Data
The LoTW Credit file from the ARRL does not indicate whether a particular record applies Mixed, Band, or
Mode credit to that QSO. As a result, LoTWCreditToDX4Win must depend on the "S"ubmitted flags that the
program inserts in QSOs when making award submissions for card credit. When examining LoTW on-line
credits, the program will use existing "S"ubmitted flags whenever possible, but when there are none it will take
a "shotgun approach" and mark the QSO as applying to all three - Band, Mixed, and Mode. In those instances
your DX4Win records may indicate three credit types when in fact the ARRL only granted one of these.
Unless/until the ARRL begins supplying better extract data there is no way to avoid that situation.

9.2. Shadow Credit Records from the ARRL
When examining my LoTW Award credit data, I found several hundred records that look like QSL Card credits
– but they describe QSOs that I had never submitted to the ARRL for Card credit. In some cases, they describe
QSOs for which I have never even received a QSL card. After some data crunching, these look like “shadow”
records of credited LoTW on-line QSOs. In those instances, there is a parallel (same date, call, band, mode)
LoTW confirmation and credit purchase. I am working with the LoTW programmers at ARRL to understand
the details, and if necessary will adjust the Card Credit processing within the program to either ignore or
recognize these card credits.
-K8UT

10. Acknowledgments
This program would be useless without the incredible DXKeeper LoTW Award Credit report from DXLabs and
Dave AA6YQ!

11. ADDENDUM I: Instructions for obtaining a DXCC Award Credit
Download Report from LOTW via DXLabs DXKeeper
DXLab is a freeware program which contains a module called “DXKeeper.” You must use DXKeeper to obtain
your current credit report from the ARRL's LoTW website in a form atha LoTWCreditToDX4Win can use.
Download DXLabs from the following URL: http://www.dxlabsuite.com/download.htm
Install the DXLauncher application first, followed by DXKeeper. Do not install these programs in
C:\PROGRAM FILES, due to problems with User Access Controls in newer versions of Microsoft Windows.
With DXLauncher running, click the <Config> button
Click the <New ?> label and install the latest versions of DXLauncher and DXKeeper software if necessary
(you can tell if their update versions are shown in red letters). Then return to the primary DXLauncher window:
<X>

Enable the DXKeeper module by clicking on the <DXK> “radio” pushbutton. It should show a green
pushbutton.
1. Click the <Start> button
2. In DXKeeper, click the <Log QSOs> tab
3. Click the <Config> button
4. Click the <Defaults> Tab
5. Enter your callsign in three places: station, operator, owner
6. Click the <Awards> tab
7. Click the <QSL Config> button
8. Click the <LotW> tab
9. Enter your LotW Username and Password
10. Exit QSL Configuration window: click <X>
11. Exit the DXKeeper Configuration window: click <X>
12. Click the <Check Progress> tab
13. Click the <Credits> button
14. Click the <Download> button (Be patient, the initial download takes a LONG time! My 2600
credits took two hours to download) This process updates the DXCC Credits Granted table in
DXKeeper.
NOTE: This step ends with a Notepad view of the Download TXT file. This is NOT the file you
need. Close Notepad and proceed to the next step.
15. Click the <Report> button. DXKeeper will automatically launch Notepad and display your
DXCC Credit report named: (yourcall) DXCC Credit Download Report (yyyy-mm-dd).txt.
Example: "K8UT DXCC Credits 2012-12-01.TXT"

SUGGESTION: Perform the download from ARRL early in the morning or late in the evening (while you
sleep), and never after a major contest!

12. ADDENDUM II: File Structures

12.1. The DXKeeper LoTW Credit .TXT File
The DXLabs DXKeeper LoTW Credit report .TXT file begins with 9 rows of header information, followed by a
row of column titles (10), a blank row (11), and LoTW Credit data beginning in row 12. Columns 1 through 96
contain QSO data relevant to LoTWCreditToDX4Win.
DXKeeper .TXT Credit Report File
Column
Function
Format
1-12
LoTW QSO number number, left jusfified (123456789)
13-22 Credit Type
string = "LotW" or "card"
41-50 Band
left justified, with M ("2M", "20M", "160M")
51-61 Mode
string = "CW", "PHONE", "DATA"
62-77 Call
callsign
78-88 Date
yyyy-mm-dd (2010-12-25)

Column
Function
89-101 Time

Format
hh:dd:ss (20:17:34) blank for card credits

12.2. The DX4Win version 8.x .DXQ Export File
Each record of your log file is exported to two rows in the .DXQ file. A log of 10,000 QSO records will contain
20,000 rows of data. The odd-numbered rows (1,3,5,7...) contain QSO data relevant to LoTWCreditToDX4Win.
The even-numbered rows (2, 4, 6, 8...) contain QSO data related to the preceding row's QSO.
DX4Win .DXQ Export File
Column N Position Function
Format
1-8
QSO DATE yyyymmdd (20101225)
9 - 14
QSO TIME hhmmss (174614)
15 - 26
CALL
left justified
27 - 29
BAND
right justified (2, 20, 160)
30 - 35
MODE
left justified (CW, SSB, RTTY)
36 - 38
rstR
left justified
39 - 41
rstS
left justified
42 - 45
Recvd
left justified
46 - 50
WPX Prefix left justified
51 - 52
CQ Zone
right justified
53
QSL Label "Y" or "N"
54 - 61
QSL Date
yyyymmdd
62
QSL Method "B", "D", "$"...
63
QSL Cnfm "Y" or "N"
64 - 65
State
two letter
66 - 87
County
left justified
88 - 92
Group
right justified
93 - 98
Grid
left justified
99 - 103
IOTA
104
QRP
"Y" or "N"
105
YLop
"Y" or "N"
106 - 109
Award Group Custom Award name
110 - 117
Award Value Custom Award value
118
Upload Sent "Y" or "N"
119
LOTW Cnfm "Y" or "N"
120 - 127
Upload Date yyyymmdd
Column
151
152
153
154

N position
1
2
3
4

Award
COUNTY
COUNTY
COUNTY
CUSTOM

Type
BAND
MIXED
MODE
BAND

Column
155
156
157
158
159
160
161
162
163
164
165
166
167
168
169
170
171
172
173
174
175
176
177

N Position Function
5
CUSTOM
6
CUSTOM
7
CQ
8
CQ
9
CQ
10
DXCC
11
DXCC
12
DXCC
13
IOTA
14
IOTA
15
IOTA
16
VUCC
17
VUCC
18
VUCC
19
WAS
20
WAS
21
WAS
22
WAZ
23
WAZ
24
WAZ
25
WPX
26
WPX
27
WPX

Format
MIXED
MODE
BAND
MIXED
MODE
BAND
MIXED
MODE
BAND
MIXED
MODE
BAND
MIXED
MODE
BAND
MIXED
MODE
BAND
MIXED
MODE
BAND
MIXED
MODE

NOTE: All dates in the .DXQ file are in YYYYMMDD format, regardless of the date format setting in your
DX4WIN preferences.

12.3. The LoTWCreditToDX4Win .NIL File
The .NIL file is formatted with both column and comma justification for viewing with a text editor (Notepad) or
reading as a CSV file in a spreadsheet (Excel).
.NIL Error Report File
Column
Function
Format
1-12
LoTW QSO number number, left justified (123456789)
14-21 Date
yyyymmdd (20101225)
24-29 Time
hhmmss (201734) blank for card credits
62-77 Call
callsign
45-47 Band
number, right justified ("2", "20", "160")
49-52 Mode
left justified string = "CW", "SSB", "DATA"

12.4. The LoTWCreditToDX4Win AUDIT.CSV File
The AUDIT.CSV file is formatted as a comma delimited file for easy sorting and analysis in a spreadsheet
(Excel).
AUDIT.CSV Report File
Column
Function
Format
A
LoTW QSO number left justified (123456789)
B
Call
Callsign
C
LoTW QSO detail Date, Time, Band, Mode
D
Type
Type of credit record (CARD or LOTW)
E
Credit flags
Mixed/Band/Mode CCC columns
F
Confirm flag
Card or LoTW confirm column
G
Card/LoTW date
Card Sent or LoTW Upload date column

